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DISCLAIMER

TO THE FULLEST EXTENT PERMITTED AT LAW, THE UNIVERSITY OF NEBRASKA-LINCOLN,
PRPOL AND IRRI ARE PROVIDING THIS SOFTWARE, WEB SITE AND ITS CONTENTS ON AN "AS
IS" BASIS AND MAKE NO (AND EXPRESSLY DISCLAIM ALL) REPRESENTATIONS OR WARRANTIES
OF ANY KIND, EXPRESSED OR IMPLIED, WITH RESPECT TO THIS WEB SITE OR THE
INFORMATION, CONTENT, MATERIALS OR PRODUCTS INCLUDED IN THIS SITE INCLUDING,
WITHOUT LIMITATION, WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. IN ADDITION, THE UNIVERSITY OF NEBRASKA-LINCOLN, PRPOL AND IRRI DO NOT
REPRESENT OR WARRANT THAT THE INFORMATION ACCESSIBLE VIA THIS WEB SITE AND
SOFTWARE IS ACCURATE, COMPLETE OR CURRENT. ANY RELIANCE UPON ANY INFORMATION
INCLUDED ON OR FOUND THROUGH OUR WEB SITE AND SOFTWARE SHALL BE AT THE USER'S
SOLE RISK. THE UNIVERSITY OF NEBRASKA-LINCOLN, PRPOL AND IRRI WILL NOT BE LIABLE
FOR ANY DAMAGES OF ANY KIND ARISING FROM THE USE OF THIS SITE AND SOFTWARE,
INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, INCIDENTAL PUNITIVE AND
CONSEQUENTIAL DAMAGES. THE UNIVERSITY OF NEBRASKA-LINCOLN, PRPOL AND IRRI
RESERVE THE RIGHT TO CHANGE INFORMATION AVAILABLE ON THIS WEB SITE WITHOUT
NOTICE. THE UNIVERSITY OF NEBRASKA-LINCOLN, PRPOL AND IRRI MAKE NO WARRANTY
THAT THE CONTENTS OF THE SITE, INCLUDING BUT NOT LIMITED TO SOFTWARE, ARE FREE
FROM INFECTION BY VIRUSES OR ANYTHING ELSE WHICH HAS CONTAMINATING OR
DESTRUCTIVE PROPERTIES AND SHALL HAVE NO LIABILITY IN RESPECT THEREOF. THIS WEB
SITE AND THE CONTENT AVAILABLE THROUGH IT ARE PROVIDED ON AN "AS IS" AND "AS
AVAILABLE" BASIS. YOU EXPRESSLY AGREE THAT USE OF THIS WEB SITE AND/OR ITS
CONTENT IS AT YOUR SOLE RISK. THE UNIVERSITY OF NEBRASKA-LINCOLN, PRPOL AND IRRI
(“WE”) DO NOT MAKE ANY WARRANTY THAT THIS WEB SITE OR ITS CONTENT WILL MEET YOUR
REQUIREMENTS, OR THAT THIS WEB SITE OR ITS CONTENT WILL BE UNINTERRUPTED, TIMELY,
SECURE, OR ERROR FREE, OR THAT DEFECTS, IF ANY, WILL BE CORRECTED; NOR DO WE
MAKE ANY WARRANTY AS TO THE RESULTS THAT MAY BE OBTAINED FROM USE OF THIS WEB
SITE OR ITS CONTENT OR AS TO THE ACCURACY OR RELIABILITY OF ANY INFORMATION
OBTAINED THROUGH USE OF THIS WEB SITE. YOU UNDERSTAND AND AGREE THAT ANY
CONTENT AND/OR DATA DOWNLOADED OR OTHERWISE OBTAINED THROUGH THE USE OF
THIS WEB SITE IS AT YOUR OWN DISCRETION AND RISK AND THAT YOU WILL BE SOLELY
RESPONSIBLE FOR ANY DAMAGE TO YOUR COMPUTER SYSTEM OR LOSS OF DATA THAT
RESULTS FROM THE DOWNLOAD OF SUCH CONTENT AND/OR DATA.

APPLICABLE LAW

THIS SOFTWARE IS AVAILABLE THROUGH WEB SITES CREATED AND CONTROLLED BY THE
UNIVERSITY OF NEBRASKA IN THE USA, PRPOL AND PPI/PPIC-IPI IN SINGAPORE, AND IRRI IN
THE PHILIPPINES. AS SUCH, THE LAWS OF THE USA, SINGAPORE AND THE PHILIPPINES WILL
GOVERN THESE DISCLAIMERS, TERMS AND CONDITIONS, WITHOUT GIVING EFFECT TO ANY
PRINCIPLES OF CONFLICTS OF LAWS: WE RESERVE THE RIGHT TO MAKE CHANGES TO OUR
SITE AND THESE DISCLAIMERS, TERMS AND CONDITIONS AT ANY TIME.
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Installation

Fertilizer Chooser requires about 62 MB of free hard disk space for a full installation and a monitor with a
graphics resolution of at least 800 x 600 pixels. As default, the program runs in a 800 x 600 pixels window.

Installation proceeds as follows:

1.
2.
3.

Download or copy file the setup file (Fert_USA.exe or Fert_Generic.exe) to a folder of your choice.
Double-click on the setup file and follow the installation instructions.

The setup program will first install the Java™ 2 Runtime Environment (JRE) SE v1.4.1. (NOTE:
Fertilizer Chooser also works with higher versions of JRE). Follow the instructions and choose Typical
as your installation option.

Following this, the setup program installs the Fertilizer Chooser software in the default directory
c:\Program Files\FertilizerChooser. This cannot be customized.

After setup is complete, click on the [Close] button and start using the program. Rebooting the
computer is not required.

Go to Start > Programs - FertilizerChooser - FertilizerChooser to launch the program.
Alternatively, start the program by double-clicking on the Fertilizer Chooser icon, which has been
placed on the desktop during installation.



Overview

What is Fertilizer Chooser?

Fertilizer Chooser is the final step in preparing a fertilizer program. It assumes that a target fertilizer
recommendation for balanced plant nutrition has been obtained by other means such as soil testing or an
existing general recommendation. Fertilizer Chooser helps the user to

Translate a nutrient recommendation into the correct amounts of different fertilizers needed to
make up the right amount of nutrients

Select a combination of meaningful fertilizer sources

Select the least costly combination of fertilizer nutrient sources based on quoted prices for
fertilizer products and the cost of application, and

Evaluate the cost of different fertilization programs.

The program uses a linear optimization procedure to find the best combination of fertilizer materials that
minimizes the cost of fertilization. Unless specified otherwise, all calculations are performed under the
constraint that the calculated amounts of fertilizer required must supply the amounts of nutrients specified
in the recommendations.

The user is encouraged to compare the total cost of different nutrient management recommendations and
fertilizer sources to make a final choice. In choosing the right fertilization program, users must also
consider other aspects that are not part of Fertilizer Chooser, including:

Product quality and consistency - these are very important factors that influence crop response to
fertilizers, application accuracy and time required for application. For example, a product such as
ammonium bicarbonate could be the "least costly" source of N available, but it may not be the
most profitable in terms of yield response, or it may cause greater environmental problems than
higher-quality products. Quality fertilizers are not available in all parts of the world, for example
when the nutrient composition of the fertilizer is lower than that stated on the bag. Implementation
of the improved fertilizer management strategies may not be effective if farmers are purchasing
fertilizer of sub-standard quality. The following strategies can be used to test for N, P and K
fertilizer adulteration:

e The most common inorganic NPK fertilizers are water soluble and should not leave any
residue on the bottom of the container containing the fertilizer dissolved in water. Exceptions
include rock phosphate, other PK fertilizers?

Dissolving urea in water produces heat from the hydrolysis.

Check the physical characteristics of granulated fertilizer. Adulterated fertilizer may be mixed
with high quality fertilizer, but the adulterated material may be of different physical properties,
and contain clay, sand, or other components. Good quality fertilizer will consist of granules
with the same physical properties.

Product preference - the user can select only specific fertilizer sources when translating a nutrient
recommendation into the correct amounts of the preferred fertilizer sources. This may be the case
when specific high quality products are to be used or if a fertilizer producer would like to develop a
fertilizer program based on official recommendations using company products.

Need for other nutrients - the need for a secondary or micronutrient may affect the choice of a
suitable P or K source and lead to use of a fertilizer that costs more per unit of nutrient. Such
considerations can be accounted for by specifying a minimum amount for a particular fertilizer
source.

Available application technology and services from the dealer. Only choose fertilizer products that
you can apply properly with the equipment available. Reliable and timely support in terms of



fertilizer delivery and/or application can be critical to making the whole fertilizer program function
properly.

Ease of handling and storage of the fertilizer. Fertilizers that contain more nutrients require less
storage space per unit nutrient than sources that contain small concentration of nutrients.

Fit in the cropping system - for example, residue management goals may determine what type of
fertilizer application is best, or weed control practices may influence the most appropriate source.

Reactivity — Some nutrients are sparingly soluble but cost less. For example, rock phosphate and
dolomite are good sources of P and Mg, respectively, but they do not dissolve well and will
improve soil fertility and crop growth only over longer time periods. More soluble sources, such as
triple super phosphate or kieserite may be more costly per unit nutrient but more effective as
nutrient sources.



Cost of fertilization
Cost of fertilization = application cost + fertilizer cost + other charges

Fertilizer cost refers to a quoted farm gate price, which differs for different materials so that the calculation
must be done on a per unit nutrient content basis to compare different sources. Application cost includes:

e Labor

e Fuel and lubricants

o Repair cost of fertilizer application equipment (power and implement)
¢ Depreciation of fertilizer application equipment (power and implement)

Other charges may include delivery fees and field trip charges, but those are assumed to be similar for
different fertilizers and not included in Fertilizer Chooser.

Example:
Recommended amount to apply: 150 Ib N per acre and 20 Ib P,Os5 per acre
Available fertilizers: Liquid starter fertilizer 10-34-0 (N, P)
Anhydrous ammonia (N)
Application: Farmer applied: planter equipped with starter fertilizer tanks;

rented company rig for anhydrous ammonia application)

Calculation of total amounts and cost of fertilization:

Step 1: Obtain the prescription: 20 Ib P,0Os5 and 150 Ib N per acre

Step 2: Chose a P fertilizer source: 10-34-0 at $ 237.50/short ton (= 2000 Ib)
Step 3: Determine P product needed per acre: 20/0.34 = 59 Ib of 10-34-0 per acre

Step 4: Determine cost of starter fertilizer: 59 x 237.5/2000 = $ 7.01/acre

Step 5: Determine N added with 10-34-0: 59 x0.10 = 6 Ib N/acre

Step 6: Determine additional N needed: 150 - 6 = 144 Ib N/acre

Step 7: Choose a N fertilizer source: NH; (82-0-0) at $ 245.00/short ton (=2000 Ib)
Step 8: Determine how much NHj; is needed: 144/0.82 = 176 Ib NHs/acre

Step 9: Determine cost of NHj: 176 x 245/2000 = $ 21.56/acre

Step 10: Determine costs of application: Liquid starter: owned planter, $ 0.36/acre

NH3: rented company rig: $ 2.72/acre
Step 11: Determine total cost of fertilization: 7.01+2156+0.36+272=  $ 31.65/acre

Data requirements
To run Fertilizer Chooser, users must enter, select, or edit:
e Crop and farm information and the overall size of the area (optional)

e Local measurement units for currency, area, and fertilizer recommendations. For all those,
conversion factors must be specified

e Target nutrient recommendation for N, P, K, and/or up to three other nutrients

¢ Names, form (e.g., solid, liquid, or gas), weight units of the fertilizers for which a price quote is
entered, quoted prices, and nutrient concentrations of locally available mineral fertilizers or other
nutrient sources.



What are the steps involved in the calculation?

Using Fertilizer Chooser involves the following steps:

1.

o o~ wDd

Start the program and adjust screen size for running the program. As a default, Fertilizer
Choosers is launched in a 800 x 600 pixels window. You can resize this window by dragging the
corners or edges to the desired size, or switch to full-screen mode using the usual Windows
controls. Fertilizer Chooser will adjust itself to any size chosen.

On the [Main] page, Select/edit local measurement units. Save settings.
Enter crop and farm information (optional)

Enter the target nutrient recommendation.

Click on button [Fertilizer Sources].

Enter/select fertilizer sources of interest. Edit weight units, prices quoted, application cost, and
nutrient concentrations for each fertilizer source. If required, enter minimum amount of a fertilizer
source that must be applied. Save your settings.

Click on button [Calculate] to find the fertilization application program with the lowest total cost
that matches the target recommendation entered.

Review the results. Compare target (recommended rates) and result. Assess amounts of different
fertilizers recommended and total cost. Assess if application of these materials is possible. If
desired, change target rates in the respective boxes on the Results page or selected different
[Fertilizer Sources] and re-calculate. Make adjustments in the final recommended amounts and
application cost. Add other nutrients to the recommendations and re-review the results. Print
results or copy them to external applications such as spreadsheet software.
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Setting measurement units

Select or define local units for currency (CU), area (AU), and fertilizer recommendations (RU). Internally,
Fertilizer Chooser performs all calculations using US$ as currency, hectare (ha) as area unit, and kg/ha as
fertilizer recommendation unit. However, users can define their own units and the program will do all
conversions and display the results in the local units chosen.

Navigate to different entries using the [TAB] key or the mouse.

New units can be defined by entering a new name and conversion factor. This will not overwrite already
existing units, but add a new entry to the list.

Use [DELETE] to erase any existing entries.

After completing your selection, press the [SAVE] button to make your choices active for the ongoing
session. This will also make your selections program defaults for future sessions.

Currency unit (CU):

Select a pre-set currency unit from the drop-down menu or define your own one by clicking on the current
entry in box CU. Changing the entry will create a new currency that will appear in addition to Dollar.
Specify the exchange rate for the new CU.

Example: Cu 1 US$ = 8.2 Yuan Renminbi (China)



Area unit (AU):

Area unit defines the locally used unit for calculating production inputs such as fertilizers or measuring
yields (e.g., acre in the USA, ha in Europe, Mu in China, Rai in Thailand). Select a pre-set area unit (acre
or ha) or define your own one by clicking on the current entry in box AU. Changing the entry will create a
new unit that will appear in addition to ha or acre. Specify the conversion factor relative to ha for the new
AU.

Example: AU 1 ha =15 Mu (China)

Recommendation unit (RU):

Recommendation unit refers to the unit typically used for prescribing fertilizer applications. Select a pre-

set recommendation unit (Ib/acre or kg/ha) or define your own one by clicking on the current entry in box
RU. Changing the entry will create a new unit that will appear in addition to kg/ha or Ib/acre. Specify the

conversion factor relative to ha for the new RU.

Example: RU 1 kg/ha = 0.133 Jin/Mu (China)

Entering crop and farm information

Entries in this section are optional and only used to provide more detailed information on the results page,
which can be printed or used otherwise.

Enter a name for the crop and field or farm for which a fertilizer program needs to be made.

If you also wish to display the results expressed as the whole amounts of fertilizer products needed for the
entire field (farm), enter the size of the field (farm) in the area unit (AU) specified above.

Entering the target nutrient recommendation

Enter your nutrient recommendations in the white boxes. Default nutrients include N, P, and K. If
applicable, select up to three other nutrients from the respective drop down lists.

All amounts entered must refer to the Recommendation unit (RU) specified. For nutrients such as P, K,
Ca, and Mg, enter the recommended rate using commonly used oxide forms (P,0s5, K;O, CaO, MgO). For
display only, all entries are also converted to elemental basis.

¢ You can use Fertilizer Chooser to just find out the cheapest fertilizer source for a single nutrient,
i.e., it is not necessary to enter a recommendation for several nutrients.

e You can define your own nutrients or a lime recommendation by overwriting the default entries in
the three [Other] columns. Note, however, that the program always maintains the same order of
nutrients and their nutrient concentrations in the table of Fertilizer Sources, which must be taken
into account for entering Fertilizer Sources. The default order is N, P,Os, K,0, S, Zn, Fe, Cu, Mn,
B, CaO, MgO.

e Check the [Ignore] check box underneath a nutrient if you wish to ignore this nutrient in the
optimization. In that case, Fertilizer Chooser will match the required amounts of all other nutrients
entered based on the available fertilizers sources selected, irrespective of whether these fertilizers
also contain the nutrient that is not required. Note that this is different from entering 0 for a nutrient
target and can lead to a result in which the actual amount suggested for the “ignored nutrient” is
less or more than what had been entered in the target recommendation. Using [Ignore] is
sometimes necessary if one already knows in advance that a certain amount of a specific fertilizer
must be applied. Irrespective of whether it represents the optimal solution or not.

e After completing all entries, click on [Fertilizer Sources] to proceed.



Examples for customization:

Ignore nitrogen in a fertilizer recommendation for lequmes: A user needs to match a target
recommendation for P and K for a legume crop such as soybean. Although no N is required for this
crop, some or all of the available fertilizer sources may contain N as well. For example, the user
knows already that P will be applied as a starter fertilizer, but all the available starter fertilizers
contains some N. In that case, check [Ignore] for N and proceed with the calculation. Fertilizer
Chooser will find the cheapest starter fertilizer solution for matching the P and K amounts required,
but the amount of N applied with these fertilizers will also be displayed. If 0 is entered in a nutrient
recommendation field (here: 0 N) and [Ignore] is not checked, no solution can be found and the
program will return an error message:

x

@ Mo salution possible . Consider selecting other fedilizer sources ar check ignore in target recommendations.
Select suitahle fedilizer sources

Cancel |

Molybdenum recommendation. Some micronutrients are not listed in the drop-down list of other
nutrients to select, but, can be calculated with some customization. For example, in any [Other] box,
replace entry Boron (B) with Molybdenum (Mo). Enter nutrient concentrations of Mo-containing
fertilizers in the column for B in the table of [Fertilizer Sources]. Note that the column title there (B)
cannot be changed, but it now refers to Mo. For running the optimization, only select those Mo-
containing fertilizers, not the original ones that contain B and may have an entry in the same B
column.

Lime recommendation. In any [Other] box, replace entry CaO with Lime. Enter the target lime rate in
CaCOj; equivalent (CCE) in the box below. Enter lime materials and their CCE in the column for
Ca0% in the table of [Fertilizer Sources]. Note that the column title there (CaO%) cannot be
changed, but the value now refers to CCE as unit, not % CaO. For running the optimization, only
select those potential liming materials that contain CCE values in the CaO% column.




Fertilizer Sources
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Enter, select, or delete available fertilizer sources. Edit weight units, prices quoted for each product,
application cost, and nutrient concentrations for each fertilizer source. If desired, enter minimum amounts
of a fertilizer product that need to be applied, irrespective of whether this represents the most cost-efficient
solution or not.

Entering and editing fertilizer sources

Fertilizer Chooser contains two default tables of common fertilizer sources, and other amendments,
including their typical nutrient concentrations, which can be loaded by clicking on File — Open and
selecting:

e default_generic.mdb generic database for worldwide use, with no weight units and prices
entered; this is the default database when Fertilizer Chooser is launched for the first time.

o default_USA.mdb generic database for the USA, with some weight units, typical prices, and
application costs entered; load this database [File — Open, browse to ...\Program
Files\FertilizerChooser and select file default_USA.mdb] if you work in the USA.

Users can edit these tables and create and save custom tables for different projects (File — Save As). Any
changes made will become program defaults, i.e., they will appear upon next restart of the program.
Perform the following operations:



Delete fertilizer sources that are not locally available or not part of your normal management. This will
make the table shorter and further selection easier. Select a fertilizer row (a selected row will appear
highlighted in blue) and click [Delete Row] to delete it from the list.

Add additional locally available nutrient sources by either:
o Overwriting and existing entry with new values for each cell in a row.

o Adding a new fertilizer in a particular group with different color-coding. Click on a fertilizer to
highlight the entire row. Then click [Insert Row]. This inserts an empty row at the top of this
group of fertilizers. Enter all details for the new fertilizer.

Click on the check boxes left to each product to select those fertilizers that should be considered as
possible choices in the fertilization program. Alternatively, click [Select All] to choose the entire list of
fertilizers.

For each selected fertilizer, verify or and enter name, type, weight unit (WU), price (CU/WU),
application cost (CU/AU), minimum amount to apply, and nutrient concentrations.

Fertilizer Source Enter a clearly recognizable name for the product

Type General fertilizer type (dry-granular, liquid, gas). Choose from the drop-

down list shown when you click on this cell. Alternatively, entering the first
letter will automatically enter the full specification (s — solid [granular/dry],
| —liquid, g — gas)

Weight Unit (WU) Product weight unit for which the price is quoted. Because prices for

different fertilizer sources may be quoted in different weights units (ton,
kg, gallon, bag, etc.), a specific WU must be selected for each fertilizer
source selected. Click on the WU cell for each fertilizer and select any of
the pre-set choices (gallon, kg, Ib, metric ton, short ton) from the drop-
down list:

Urea (46-0-0) solid
Urea ammanium hitrate {28-0...[liguid |gallon

-
[ | |Urea ammonium nitrate (32-0..|liguid kg
[ lAmmonium polyphosphate (1. [liquid (b
[
[ |

Diammanium phosphate (18-...|salid  [metric ton
Monoammonium phosphate (. |[solid

To define a new WU, click on View > Weight Units in the menu bar at
the top of the screen. A dialog box will pop up with all pre-set choices.
Enter a name for a new unit you wish to define and the correct conversion
factor to relate this unit to kg as the standard unit used in program-internal
calculations. Click [Save] to add the new unit to the list, and make it
available for any fertilizer source:

x
1 bag =|=| s0Kg
Delete | Save | Exit
Price (CU/WU) Fertilizer price quoted per specified weight unit (WU). Enter the price in

the same currency unit as defined on the opening screen (CU). The
currently selected CU is also displayed at the top of the [Fertilizer
Sources] screen
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Application Cost (CU/AU)

Minimum Amount (RU)

Nutrient concentrations (%)

Estimate of total application cost, expressed on an area basis (CU/AU)
using the currency (CU) and area units (AU) defined under [Home].
Application cost includes:

Labor

Fuel and lube

Repair cost of fertilizer spreader (power and implement)
Depreciation of fertilizer spreader (power and implement)

Note that application costs vary depending on the type of fertilizer,
available equipment and services, and the amount of labor needed.
Application costs are often expressed on a per area basis (e.g., $ per
acre), but, occasionally, also on a per unit fertilizer basis (e.g., $ per ton
applied). NOTE: in Fertilizer Chooser, application costs must be entered
on a per area basis.

If no estimate of application cost is available or desired, set all values to
zero and proceed running the calculation without it.

If several fertilizers will be blended and applied with the same application
pass, specify the application cost only once or divide it among those
fertilizers that are applied together.

Where applicable, average application cost numbers such as those
shown below can be used.

Example: Typical application costs for farmers in Nebraska, USA

Anhydrous ammonia company rig (rental) $2.50/acre
Anhydrous ammonia owned rig $5.30/acre
Anhydrous ammonia custom applied $6.20/acre
Dry fertilizer company spreader (rental) $1.20/acre
Dry fertilizer custom spinner $4.00/acre
Dry fertilizer custom air flow $5.50/acre
Liquid fertilizer company sidedress (rental) $2.35/acre
Liquid fertilizer custom injection $6.00/acre
Liquid fertilizer custom floater $5.50/acre
Liquid starter add-on planter $0.35/acre

Enter the minimum amount of a particular fertilizer, expressed in the
recommendation unit (RU) selected. This is useful under certain
conditions. For example, you know already that you will apply a certain
amount of a specific fertilizer with your planter as starter fertilizer, but wish
to find out how to match the total target recommendation with other
nutrient sources at the lowest cost. A minimum amount may also be the
smallest feasible rate that can be reliably applied with a particular fertilizer
spreader. Set all minimum amounts to zero if no such constraints exist.

For each fertilizer source to be included, enter/edit the respective nutrient
concentrations as indicated.

BEFORE PROCEEDING WITH THE CALCULATION, ALWAYS MAKE SURE THAT ALL FERTILIZERS
SELECTED HAVE COMPLETE INFORMATION ON WU, PRICE, AND NUTRIENT CONCENTRATIONS.
EMPTY FIELDS IN ANY OF THOSE MAY LEAD TO ERRONEOUS RESULTS.

e Click [Calculate] to find the optimal solution for the fertilization program.
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Results

—lolx]
File View Help
Crop/Farm Info
Crop Name ICorn Field IFox Run Total Area I 100 pere
N P205 K20 [other | Joter =] Jother |
Target (Ib/acre) I 150 I 0 I a0 I I I
Result (bjacre) | 150 | 50 | 50 | 0 | 0 | 0
Nutrients supplied with each fertilizer
Recommended Fertilizers | N | P05 | Ko | other | other | other |
Urea (46-0-0) 130 0 0 0 ] 0
Diamrmonium phosphate (18-46-0) 20 50 0 0 ] 0
Fotassium chloride (MOP 0-0-60) u] 0 a0 0 u] 0
Recommended amounts and cost of fertilization
Recommended Fertilizers | Price | (CUMU) | App.Cost{CU/AU) | AmountiRU) | CostiCU/AU) | Total Amountill) | Total Costicu) |
Urea (46-0-0) 2500 Dollar'short ton 40 2836 39.4 28,360 3540
Diarnmonium phosphate (18-46... 230.0 Dollar/short ton 4.0 108.8 16.5 10,880.1 1,650
Fotassium chlonde (MOP0-0-...  160.0 Dollar/short ton 4.0 833 17 8,330 1070
Total 120 475.7 66.6 47,5701 6,660
CU - Currency Unit {Dollar: United States) AU - Area Unit {Acre) RU - Recommendation Unit {Ib/acre) Total amount Unit Ilb vl
FertilizerSources Home | Help | Save As | Copy to Cliphoard | Print | Exit |

Verify that the resulting nutrient recommendation matches the target amounts entered. Review what
fertilizer sources have been chosen how much each of them contributes to the different nutrients amounts
in the target recommendation. Assess the amount and cost of recommended materials as well as the total
cost of the entire fertilization program. Prices of fertilizers displayed here refer to the Weight Units
specified for each fertilizer source, which may differ among different products. Final costs of each product
and of the entire fertilization program are expressed in the currency unit per area unit selected (CU/AU)
and include the fertilizer amounts needed as well as the application cost. The total amount of fertilizers
needed as well as the total costs for the entire field (farm) are displayed in the last two columns.

Possible actions include:

Manually adjust the recommended amounts of fertilizers. This may make sense if the program

suggests applying a very small amount of a fertilizer source or if you simply want to round the
numbers. Double-click on a cell in column “Amount” to perform such changes. Observe effects of your
adjustments on the total cost and the amount of recommended nutrients (compare target and actual
nutrient content). NOTE: prices of fertilizers can only be changed by going back to [Fertilizer

Sources].

Manually adjust the application cost of different fertilizers. This may make sense if the program

suggests applying several granular (dry) fertilizers, which could be made into a custom blend so that
the application cost applies only once.
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Re-run the calculation with different target amounts to evaluate alternatives and how they affect the
cost. Change the target amount directly on the [Results] screen and the program will automatically
update the results displayed. Study repeatedly how changing amounts of one or more nutrients affects
the total cost to decide on the best compromise between minimizing cost and sustaining soil fertility
and yield.

Re-run the calculation with different fertilizer sources to evaluate alternatives and how they affect
the cost. Click on [Fertilizer Sources] to change those selections.

Re-run the calculation with other nutrients added to evaluate alternatives and how they affect the
cost. Select other nutrients and their target amounts directly on the [Results] screen and the program
will automatically update the results displayed. Study repeatedly how changing amounts of one or
more nutrients affects the total cost to decide on the best compromise between minimizing cost and
sustaining soil fertility and yield. NOTE: if a nutrient is selected for which no suitable fertilizer sources
has been selected before, an error message will be displayed:

x

@ Mo solution possible.Consider selecting other ferdilizer sources or check ignore in target recommendations.
Select suitahle fedilizer saurces ?

Cancel |

Click [OK] to select suitable fertilizer sources. Click [Cancel] to cancel the nutrient selected.

Change the unit in which the total fertilizer amount for the entire field (farm) is displayed:

RU - Recommendation Unit {Ihfacre) Total amount Unit [Ib ll
gallon
kq
Save As Copy to Cliphoard | Print | Ex]
metric ton
short ton

Copy the result to an external application for further processing. Click on [Copy to Clipboard] and
paste results in any application of your choice. Alternatively, click [Save As] to save the entire result
page in spreadsheet format (*.csv file).

Print a hardcopy of the final result page by clicking [Print]

Suggestions:

Small changes in target amounts have little effect on the overall cost of fertilization, but they may
decrease or increase yield potential and yield stability (risk). If uncertain, do not reduce the actual rate
applied much below recommended levels.

On a per unit nutrient basis, compound fertilizers may be more expensive than single nutrient
fertilizers. Explore if this is true for your location, but also take into account differences in application
cost. A compound fertilizer may still be a good choice if convenience of application is a key decision
criterion. Otherwise, explore whether application of custom blends made from single nutrient sources
would be a more cost-efficient solution.

Explore how application cost affects the total cost and decide whether buying or renting equipment is
a better option than custom application.

Evaluate your final choice with regard to all other factors to consider:

e Product quality and consistency - these are very important factors that influence crop response to
fertilizers, application accuracy and time required for application. For example, a product such as
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ammonium bicarbonate could be the "least costly" source of N available, but it may not be the
most profitable in terms of yield response, or it may cause greater environmental problems than
higher-quality products.

Need for other nutrients - the need for a secondary or micronutrient may affect the choice of a
suitable P or K source and lead to use of a fertilizer that costs more per unit of nutrient. Such
considerations can be accounted for by specifying a minimum amount for a particular fertilizer
source.

Available application technology and services from the dealer. Only choose fertilizer products that
you can apply properly with the equipment available. Reliable and timely support in terms of
fertilizer delivery and/or application can be critical to making the whole fertilizer program function

properly.

Ease of handling and storage of the fertilizer. Fertilizers that contain more nutrients require less
storage space per unit nutrient than sources that contain small concentration of nutrients.

Fit in the cropping system - for example, residue management goals may determine what type of
fertilizer application is best, or weed control practices may influence the most appropriate source.

Reactivity — Some nutrients are sparingly soluble but cost less. For example, rock phosphate and
dolomite are good sources of P and Mg, respectively, but they do not dissolve well and will
improve soil fertility and crop growth only over longer time periods. More soluble sources, such as
triple super phosphate or kieserite may be more costly per unit nutrient but more effective as
nutrient sources.
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Example 1: Irrigated corn in Nebraska, USA

1. Enter and save the measurement units for this region. Select US Dollar as Currency Unit, Acre as
Area Unit and Ib/acre as Recommendation Unit. Verify that the conversion factors are correct. Click
[Save] to make your selection active.

Units
currency Unit Area Unit Recommendation Unit
1Us$=| 1.0 |Dollar: United States  v| 1ha=| 2.4700acre || 1kgma=| 08928 )biacre -]

Save | Delete |

2. Enter the Crop/Field information: We assume a 100-acre field to be planted with irrigated corn:

Crop/Farm Info

Crop ICorn Farm/FieldID IFox Run Total Area I 100 Acre

3. Enter the target amounts of nutrients to apply: irrigated corn is grown on a sandy soil with low organic
matter content, low available P and K. Soil testing was done and the existing recommendation
algorithms suggest to apply the following to meet crop needs for a 200 bu/acre yield goal:

| N | | P»0s | | K,0 | Is ﬂ IOther Ll Iother Ll
Ibiacre Ib/acre
Target Amounts I 185 | 40 I 40 I 10 I | |
Equivalent in Element | 185 | 17 | 33 | 10 | |
[ lgnore [~ lgnore [ lgnore [ lgnore [ lgnore [~ lanare
| Fertilizer Sources | Calculate Help About Exit

Copyright 2004 by University of Nebraska-Lincoln, Pacific Rim Palm Oil Limited, and International Rice Research Institute. All rights resenred.

4. Select and edit locally available fertilizer sources. Choices to consider are:

Nitrogen sources: Anhydrous NH3;, $300/short ton, $5/acre application cost (owned rig)
UAN 32%, $150/short ton, $6/acre application cost (custom floater)
Urea, $250/short ton, $4/acre application cost (custom spinner)

Phosphorus sources: DAP, $230/short ton, $4/acre application cost (custom spinner)
MAP, $250/short ton, $4/acre application cost (custom spinner)
10-34-0 (liquid), $230/short ton, $6/acre application cost (custom floater)

Potassium sources: KCI (muriate of potash — MOP), $160/short ton, $4/acre application cost (custom
spinner)
Sulfur sources: Sulfur, $300/short ton, $4/acre application cost (custom spinner)

Potassium-Magnesium-Sulfate, $195/short ton, $4/acre application cost
Ammonium sulfate, $230/short ton, $4/acre application cost (custom spinner)
Other sources: Starter 8-20-5-5, $200/short ton, $0.3/acre application cost (planter)
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EFertilizer Sources { default_usa.mdb ¥

File View Help

I [=[ 3]

CU = Currency Unit (Dellar: United States)
U/aU = Application Cost (Dollar: United States/Acre)

AU = Area Unit ( Acre )
CUMWU = Fertilizer price gquote

RU = Recommendation Unit { Ib/acre )
WU = Weight Unit (for fertilizer price gquote

Select All | Deselect All |

- Ferilizet Source Type | Weight... Price AppCost | Min Am... K| P20A| K2O g Zn Fe Cu in B Cao | MgO
Ly | ULy | sl | (RUY % % % % % % % % % % %
v [Ammonium sulfate (21-0-0-24) |solid |shortton 2300 4.0 0.0 21.0 24.0
Iv| |Anhydrous ammonia solid |shortton 300.0 a.0 0.0] 82.0 0.0
v |Urea (46-0-0) salid |shortton 260.0 4.0 0 46.0
Iv| |Urea amrmonium nitrate (32-0-.._|liguid |shor ton 150.0 B 0.0 320
v |10-34-0 liguid |shart ton 230.0 &1 00 100 340
Iv| |Diammaonium phosphate (18- |solid |shor ton 2300 a0 0.0/ 18.0f 46.0
Iv| |Monoamrmonium phosphate (.. |solid |shorton 2500 4.0 0.0 11.0f 52.0
| |Superphosphate, triple <olid |shortton 2300 4.0 0.0 45.0 1.5 18.0
Iv| |Fotassium chloride (MOP,0-0-... |solid |shorton 160.0 4.0 0.0 60.0
I |Potassiur-rmagnesium Sulfate [solid | shortton 185.0 4.0 0.0 2200 22.0 18.0
v |Starter 8-20-5-5-0.5 liquid |short ton 185.0 0.3 0.0 4.0 200 5.0 5.0 0.4
2l Sulfur solid |shor ton E:Dl:l_l:lm- 0.0 90.0

Insert Row I Delete Row |

Help | Home | Calculate

5. Click [Calculate] and review the result:

EFertiIizer Reports

File View Help

Save those choices in a custom table by clicking on File > Save As

I [m[ 3]

rop/Farm Info
Crop Name ICOrn Field IFox Run Total Area I 100 pere
N P205 K20 [s | |other | |other d|
Target (Ib/acre) | 185 | 10 | 40 | 10 | |
Result (bacre) | 185 | a0 | 40 | 10 | 0 | 0
~Hutrients supplied with each fertilizer
Recommended Fertilizers | n | pos | k2o | s | oOther | Other |
Anhydrous amrmonia 169 0 0 0 ] 0
Diarmmaonium phosphate (18-456-0) 16 40 i} i} u] 0
Fotassium chloride (MOP 0-0-60) u] 0 40 0 u] 0
Sulfur u] 0 0 10 u] 0

rRecommended amounts and cost of fertilization
{CUANU)

Recommended Fertilizers | Price | | App.Cost{CU/AL) | AmountiRU) | Cost{CU/AL) |  Total Amount(lh) | Total CastiCU) |

Anhydrous ammaonia 300.0 Dollar/short ton 5.0 206.5 36 206499 3R00 .~
Diarmmonium phosphate (18-4...  230.0 Dollar/short ton 4.0 86.9 14 g /50 1.400
Potassium chloride (MOP 0-0-... 160.0 Dollar/shart ton 40 =515 93 5 BB0.1 o930
Sulfur 300.0 Daollar/short ton 4.0 11.1 a7 1,110 &70
Total 17.0 3711 65 37,110 6,500 7
CU - Currency Unit {Dollar: United States) AU - Area Unit {Acre) RU - Recommendation Unit {Ibiacre) Total amount Unit Ilb vl
FertilizerSources | “Home Help | Save As | Copy to Cliphoard | Print | Exit |

The total cost of this fertilizer program is $65/acre. Anhydrous ammonia is the most cost-effective N
source available and supplies most of the recommended N dose. DAP, MOP, and sulfur are the other
least-costly nutrient sources to match the target recommendation. However, because the soil at this
site is of sandy texture injecting 207 Ib/acre anhydrous ammonia as one pre-plant dose may cause
significant N losses, resulting in lower yield than expected. Therefore, we make the following change:
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Under [Fertilizer Sources], specify a minimum amount of 300 Ibs 32-0-0 (urea-ammonium-nitrate
solution; 300 Ibs x 0.32 = 96 Ibs N/acre) to be applied as three fertigations through the center-pivot
irrigation system at different growth stages. This will provide better congruence of N supply with crop
N demand and perhaps results in higher yield than a single anhydrous application. The application
cost associated with this is small and we assume $1/acre:

shaortton

150.0

Fertilizer Source Type | Weight... Frice AppCost | Min Am... M| P205| K20 g zn Fe Cu in B Cao | MgO
L | cunay | cwialy | (RU) % % % % % % % % % % %
v |Armmaonium sulfate (21-0-0-24) |solid |shortton 230.0 4.0 o.of 2.0 240
v |Anhydrous ammonia salid |shartton 300.0 5.0 0ol 820 0.0
solid |shortton 250.0 4.0 0aof 460

Clicking on [Calculate] results in the revised solution, now including anhydrous ammonia (pre-plant),
32-0-0 (fertigations), DAP, MOP, and sulfur (all pre-plant). The total cost of the modified fertilizer
program is $68.8/acre. This is only $3.8/acre more than the original solution and a yield increase of
just 2 bu corn/acre would easily make up for that extra cost.

As a next step, we need to consider that DAP, MOP, and sulfur could probably be applied as a
custom blend in one pre-plant pass Consequently, the application cost of $4/acre should only be
applied once to the cost calculation. Therefore, we make the following change:

Under [Fertilizer Sources] or directly on the [Results] page, we set the values for application cost to
$4/acre for DAP, but $0/acre for MOP and Sulfur, assuming that those would be blended with the
DAP. Recalculate.

File View Help

I [m[ 3]

ropFarm Info
Crop Name ICorn Field IFox Run Total Area I 100 pcre
N P205 K20 Is | |oter =] Jother |
Target (Ib/acre) I 185 I 40 I 40 I 10 I I
Result (biacre) | 173 | 10 | a0 | 10 | 0 | 0
rNutrients supplied with each fertilizer
Recommended Fertilizers | n | pos | k2o | s | oOther | Other |
Anhydrous ammaonia B2 0 0 0 u] 0
Urea ammonium nitrate (32-0-0) 95 0 0 0 u] 0
Diamrmonium phosphate (18-46-0) 16 40 0 0 ] 0
Fotassium chloride (MOP 0-0-60) u] 0 40 0 u] 0
Sulfur 0 ] ] 10 0 i]

~Recommended amounts and cost of fertilization

Recommended Fertilizers | Price | (CUMWL) | App.Cost(Cu/AL) | Amount(RU) | CostiCu/al)y | Total Amount(il) | Tatal Costicu) |
Anhydrous ammaonia 0 Daollar/zhort ton 5.0 7a.4 16.3 7h39.9 1,630;[
Urea ammonium nitrate (32-0-0)  150.0 Dallar/short ton 1.0 300 2348 30,000 2,350
Diamronium phosphate (18-4...  230.0 Dollar/short ton 40 896.9 14 8590 1,400
Fotassium chloride (MOP 0-0-...  180.0 Dallar/short ton 0.0 BB.6 53 B BRO.1 530
Sulfur 300.0 Dollar/short ton 0o 1.1 1.7 1,110 170

Total 100 540 60.8 54,000 6,080 ~
CU - Currency Unit {Dollar: United States) AU - Area Unit {Acre) RU - Recommendation Unit {Ibiacre) Total amount Unit _3
FertilizerSources I Home | Help | Save As Copy to Clipboard | Print | Exit |

Our final result is now $60.8/acre or $6080 for the entire field. This program can be implemented well
and it ensures high N use efficiency and profit.

17



We may also evaluate the cost of a fertilizer program that includes a starter fertilizer since our planter
is equipped for this. For example, a fixed amount of 60 Ib/acre 8-20-5-5 starter could be applied during
planting to boost emergence and early vegetative growth of corn on this sandy soil.

Under [Fertilizer Sources], enter 60 Ibs/acre as minimum amount for this starter fertilizer and review
the result:

RT=TE

File View Help

Crop/Farm Info

Crop Name  [com Field [Fox Run Total Area | 100 pcre

: e T
g [ W [ w [ m [ w |
Result (bjacre) | 173 | 39 | 40 | 10 | 0 | 0

Mutrients supplied with each fertilizer

Recommended Fertilizers | n | pos | k2o | s | oOther | Other |
Anhydrous amrmonia 62 0 0 0 ] 0
Urea ammonium nitrate (32-0-0) 96 i} i} i} u] 0
Diarnmonium phosphate (18-456-0) 10 27 0 0 u] 0
Fotassium chloride (MOP 0-0-60) u] 0 37 0 u] 0
Starter 8-20-5-5-0.5 &} 12 3 3 0 i]
Sulfur u] 7 u] 0
Recommended amounts and cost of fertilization
Recommended Fertilizers | Price | (CUMWU) | App.Cost{CU/ALY | Amount(RU) | Cost(CU/AU) | Total Amountlb) | Total Cost(CU) |
Wnhydrous ammaonia 300.0 Dollarishort ton 5.0 783 163 7 .A30 1630
Urea ammonium nitrate (32-0-0)  150.0 Dollar/short ton 1.0 300 235 30,000 2350
Diamrmonium phosphate (18-46... 230.0 Dollar/short ton 40 57.8 106 5,780 1,060
Fotassium chloride (MOP 0-0-...  160.0 Dollar/short ton 0o G1 49 G,100.1 4590
Starter 8-20-5-5-0.5 196.0 Dollar/short ton 0.3 =in} 6.1 65,000 610
Sulfur 300.0 Dollar/shart ton 0.0 74 11 7401 110
Total 10.3 561.5 62.5 56,150.2 6,250
CU - Currency Unit (Dollar: United States) AU - Area Unit (Acre) RU - Recommendation Unit {Ib/acre) Total amount Unit Ilh vl
" Fertilizersources ||  Home | Help | Save s | Copy to Cliphoard | Print | Exit |

The additional cost of the starter fertilizer is $1.7/acre, which is less than 1bu/acre yield. It may be well
worth spending that extra money. Also note how the amounts of DAP, MOP, and Sulfur have been
adjusted downwards to account for the nutrient amounts provided by the starter fertilizer.

Proceed to [Save As] or [Print] the result.

Try various other options to identify the fertilizer program that best fits your needs. You may also
evaluate how much extra money you would have to invest to apply larger amounts of one or more
nutrients, including micronutrients. For example, you may wish to invest in building up soil P levels.
Evaluate what it would cost to apply 100 Ib P,Os/acre as compared to just 40 Ib P,Os/acre. Change
the target recommendation for P on the results page to 100 and re-calculate. The increased P amount
adds $11/acre to the total cost of the fertilizer program.
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Example 2: Irrigated rice, Philippines

1.

Select Philippine Peso (PhP) and enter the exchange rate to the US$, then select Hectare as Area
Unit and kg/ha as Recommendation Unit used in the Philippines. Verify that the conversion factors are
correct. Click [Save] to make your selection active.

Units
Recommendatien Unit

|| 1kama= | 1.0 Ikgfha =]

Delete |

Currency Unit Area Unit

1Uss=|  50.0 |Peso: Philippine || tha=|  1.0jHectare

Save |

Enter the Crop/Field information: We assume a 2.5 ha farm to be planted with irrigated rice in the dry
season:

Crop/Farm Info

Crop Rice Farm/FieldID Lazo Total Area 25 Hectare

Enter the target amounts of nutrients to apply: irrigated rice is grown on Vertisols and Inceptisols with
medium to heavy texture (clay loam to clay), moderate organic matter content, low extractable Olsen-
P, and low exchangeable soil K level. Omission plots were installed to estimate the indigenous soil
nutrient supplies of N, P and K, and fertilizer recommendations were worked out according to the site-
specific nutrient management approach for rice (www.knowledgebank.irri.org/ssnm).

The following rates of N, P, and K are recommended to achieve target yields of 6.0 t0 6.5 t ha™ in the
dry season (DS)and 5.0t0 5.5t ha™ in the wet season (WS):

Nutrient addition (kg/ha)
Nutrient Dry season Wet season
Transplanted rice Broadcast seeded rice Transplanted rice
N 130" 130* 80*
P,05 35 35 20
K;0O 65 65 20

* The fertilizer N requirement varies from season to season and adjustments will be made during the season.

In our example, we focus on the DS recommendation and enter:

=z

Iother 4 |other ] IOther i

kg/ha

Target Amounts I 130

| 35 | &5 |

Equivalent in Element I 130

[ lgnore

e !

[ lgnore [ lgnare [ lgnare

[ lanore [ lgnore

Fertilizer Sources |

Calculate | Help |

Exit |

Select and edit locally available fertilizer sources. First, we need to define “bag” as a new fertilizer
weight unit. On page [Fertilizer Sources], go to View - Weight Unit and define “Bag” as the new
unit:

Y
1 bay =l=| 50Ky
Delete | Exit |
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Fertilizer Choices to consider are:

Nitrogen sources:

Phosphorus sources:
Potassium sources:

Ammoniumsulfate (21-0-0): 278 PhP per 50 kg bag
Urea (46-0-0): 530 PhP per 50 kg bag,

Solophos (0-18-0): 303 PhP per 50 kg bag

KCI (muriate of potash - MOP): 454 PhP per 50 kg bag

Combined fertilizers

14-
17-
17-
16-
20-

14-14 465 PhP per 50 kg bag
7-17 475 PhP per 50 kg bag
0-17 485 PhP per 50 kg bag
20-0 419 PhP per 50 kg bag
10-0 400 PhP per 50 kg bag

Edit/enter all those fertilizers, prices, and nutrient concentrations. No application costs are specified.
Save your customized fertilizer table (File > Save As):

®BFertilizer Sources ( rice_Philippines.mdb ) o [=] [}
File WView Help
CU = Currency Unit (Peso: Philippine} AU = Area Unit { Hectare ) RU = Recommendation Unit { kg/ha )
CU/AU = Application Cost (Peso: Philippine/Hectare) CUMWU = Fertilizer price quote WU = Weight Unit (for fertilizer price quote )
FERTILIZER SOURCES
5. Fertilizer Source Type |¥Weightl). Price AppCost | Min Amo.. ™ P205| K20 5 n Fe Cu Mn B Cao | MgQ
(wu) (CUWU) | (CUALY (RU} % % % % % % % % % % %
[+ |Ammonium sulfate solid  |hag 278.0 0.0 0.0 2.0 24.0
[ |Urea solid  |bag 5300 0.0 00 460
[ |Diammonium phosphate (DAP) solid 0.0 0.0 180 460
[ |Solophos (0-18-0) solid  |bag 303.0 0.0 0.0 18.0 480
[ |Supemphosphate, triple solid 0.0 0.0 45.0 1.5 18.0
[ |Paotassium chioride (MOF) solid  |bag 45410 0.0 0.0 0.0
[ |Potassium nitrate solid 0.0 00/ 13.0 44.0
[ [14-14-14 solid  |hag 465.0 0.0 0.0 140 140 140
[v |18-20-0 solid  |hag 419.0 0.0 0.0 16.0] 200
[ [17-0-17 solid  |hag 485.0 0.0 0o 17.0 17.00
v [17-7-17 solid  |hag 475.0 0.0 0.0 17.0 7.00 17.0
[ |20-10-0 solid  |hag 400.0
[ |Zinc sulfate solid 0.0 0.0 36.0
Select All | Deselect All | Insert Row | Delete Row Help | Home |I Calcuiate

5. Click [Calculate] and review the result:

™A Fertilizer Reports

=18

File “iew Help

rop/Farm Info
Crop Name

IRice Field Lazo

Total Area 25 yoctare

N P205 K20 [other =] |other =] other |
Target (kytha) | 130 | 35 | 65 | [ [
Resultkg/ha) | 130 [ 35 | 65 | 0 [ 0 [ 0
~MNutrients supplied with each fertilizer
Recommended Fertilizers | N | P05 | K20 | oOther | Other | other |
Urea m i ] 0 i i
Potassium chloride (MOP) o o B5 o o o
16-20-0 bl k3 i i il il
R and cost of fertilization
Recommended Fertilizers | Price | (CUMU) | App.CostiCUAU) | AmountiRU) | Costcu/au | Total Amount{kg) | Total Costicu) |
Urea 530.0 Pesobag 0.0 217 2350 5543 5 TR
Fotassium chloride (MOF) 454.0 Peso/bag 0.0 108.3 983 4 2708 24585
16-20-0 419.0 Pesafbag 0.0 175 1 4665 1375 36663
Total 0.0 505 4,799.9 12626 11,999.8

CU - Currency Unit (Peso: Philippine)

AU - Area Unit (Hectare)

RU - Recommendation Unit (kgha)

Total amount Unit (kg hd

FertilizerSources I Hol

me | Help |

Save As

Copy to Clipboard

| Print | Exit |
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The result matches the target and the least costly combination of fertilizers includes urea, MOP and
16-20-0 as nutrient sources, resulting in a cost of 4800 Pesos per hectare. However, since all fertilizer
P should be applied shortly before or after crop establishment, applying 175 kg of 16-20-0 would not
only supply all targeted fertilizer P, but also 28 kg N/ha. A smaller N dose of 20 kg N/ha would be
desirable early in the season when plants are still small and fertilizer N requirement is low. Therefore,
in a second run, we evaluate how the result would change if only single-nutrient fertilizers were
chosen. De-select all compound fertilizers under [Fertilizer Sources] and re-run the calculation:

™A Fertilizer Reports =10 x|

File View Help

rop.Farm Info
"(Crop Name Rice Field Lazo Total Area 2.5 Hectare

N P205 K20 [other x| [other | |other =l
Target (katha) | 130 | 35 [ 5 [ [ [
Result (kytha) | 130 [ 35 [ 65 [ 0 [ 0 [ 0

~Nutrients supplied with each fertilizer

Recommended Fertilizers N | P05 | K20 | other | other | other |
Urea 130 0 ] 0 0 ]
Solophos ([0-18-0) 0 kL i 0 q i
Fotassium chloride (MOP) o o B o o 0

and cost of fertilization

Recommended Fertilizers | Price | (CUMU) | App.Cost(CU/AU) | Amount(RU) | CosyCU/AU) | Total Amounttkg) | Total Cost(CU) |
Urea 530.0 Pesofbag 0o 2626 299556 7085 7483 |
Solophos (0-18-0) 303.0 Pesarbay 0o 194.4 1,178.1 486 25453
Potassium chloride (MOP) 454.0 Pesolbag 0.0 108.3 933.4 2708 24585

Total 0.0 585.3 5,157.1 1,463.3 12,892.82
CU - Currency Unit {Peso: Philippine) AU - Area Unit (Hectare) RU - Recommendation Unit (kyha) Total amount Unit Ikg LI
| FertilizerSources | Home | Help | Save As | Copy to Clipboard | Print | Exit |

This combination of fertilizer sources is about 360 PhP/ha or 7 US$/ha more expensive than the
previous solution, but would allow splitting N as desired. However, farmers in the Philippines often
prefer to use combined fertilizers because of greater convenience. Therefore, in addition to the
previously selected single-nutrient fertilizers, we also select 14-14-14 under [Fertilizer Sources] and
review the result again:

=1olx|

File Wiew Help

ropiFarm Info
Crop Name IRice Field ILazo Total Area I 25 jectare

N P205 K20 [Other =] [other =| [other =l
Target (kgha) | 130 | 35 [ 65 | [ [
Result (ky/ha) | 130 | 3 | 65 | 0 [ 0 | i

Hutrients supplied with each fertilizer

Recommended Fertilizers N | p05 | K20 | other | other | other |
Urea 95 i} i} i} i} i}
Potassium chloride (MOP) u] u] 30 u] u] u]
14-14-14 38 38 38 0 0 0
R and cost of fertilization
Recommended Fertilizers | Price | {CUMU) | App.Cost{CU/AU) | Amount(RU) | Cost(CU/AU) | Total Amountkg) | Total Cost(CU) |
Urea 530.0 Peso/bag oo 206.5 2,188.8 5816.3 54723 2
Fotassium chloride (MOF) 454.0 Peso/bag oo 50 454 125 1135
14-14-14 465.0 Pesotbay ulu] 250 2328 B25 58125
Total 0.0 506.5 4,967.9 1,266.3 12,419.8 =
CU - Currency Unit {(Peso: Philippiney AU - Area Unit (Hectare) RU - Recommendation Unit (kg/ha) Total amount Unit |kg -
FertilizerSources | Home | Help | Sawve As Copy to Cliphoard | Print | Exit | ‘
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e This selection suggests to apply 250 kg 14-14-14 as the only P source early in the season. This
would, however, also provide 35 kg N/ha of pre-plant N. To avoid this problem, we set the constraint
to use at least two bags of Solophos/ha. Under [Fertilizer Sources], we specify 100 kg/ha as
minimum amount for Solophos and recalculate:

=

File Wiew Help

rop/Farm Info
Crop Name

IRice Field ILazo Total Area I 2.5 Hectare

N P205 K20 [other | |other =] other =]
Target (kg/ha) I 130 I 35 I 65 I I I
Result (kyyha) | 130 | 35 | 65 | 0 | 0 | 0
rNutrients supplied with each fertilizer
Recommended Fertilizers N | p205 | K20 | other | Other | Other |
Urea M3 u] u] u] u] u]
Solophos (0-18-0) i 18 i i i i
Potassium chloride (MOP) u] u] 45 u] u] u]
14-14-14 17 17 17 o o o
R and cost of fertilization
Recommended Fertilizers | Price | {CuavU) | App.CostiCU/aU) | Amount{RU) | CostiCW/AU) | Total Amountkg) | Total Costicl) |
Urea 530.0 Peso/bag oo 2457 2604.4 B614.3 6511 4]
Solophos (0-18-0) 303.0 Peso/bag oo 100 608 250 1515
Patassium chloride (MOP) 454.0 Pezo/bag oo 80 FHA 200 1818
14-14-14 48511 Pasnfbag nn 1214 1128 3035 A5
Total 0.0 547 .1 5,065.8 13678 12.664.5
CU - Currency Unit (Peso: Philippine) AU - Area Unit (Hectare) RU - Recommendation Unit (kg/ha) Total amount Unit |kg hd
“Fertilizersources Home | Help | Save As | Copyto Cliphoard | Print | Exit |

e This solution satisfies all needs. Phosphorus is all applied early as Solophos and 14-14-14, some K is
applied with the 14-14-14, more K can be applied later during the growing season, and the amount of
pre-plant N is kept small (17 kg N/ha). All remaining N can be applied as urea in various splits
throughout the growing season and using diagnostic tools such as a Leaf Color Chart (LCC).

6. For the final recommendation, we round the application amounts to 2 bag (25 kg) amounts:

File  Wiew Help

rop/Farm Infor
Crop Name

=181x]

lmce— Field I,_azo Total Area 25 Hectare

N P205 K20 [other = Jfother = other =]
Target (kg/ha) | 130 | 35 | 65 | | |
Result (fcg/ha) | 133 | 3 | 63 | 0 | 0 | 0
rNutrients supplied with each fertilizer
Recommended Fertilizers N | P05 | K20 | other | oOther | oOther |
Urea 13 o o o o o
Salaphos (0-18-0) il 14 il il il il
Potassium chloride (MOP) o o 438 o o o
14-14-14 17 17 17 1] 1] 1]
Ri and cost of fertilization
Recommended Fertilizers | Price | (CUMU) | App.Cost(CU/AL) | Amount(RU) | CosiCU/AU) | Total Amount(kg) | Total Cost(cl) |
Urea 530.0 Peso/bag oo 280 26500 625.0 BE50.0 =
Solophos (0-18-0) 303.0 Pezo/bag oo 100 B06 250 14515
Fotassium chlaride (MOP) 454.0 Peso/bag oo 75 631.0 187.5 17275
14-14-14 465.0 Peso/bag oo 125 1625 325 2931.3
Total 0.0 450.0 5099.5 187.5 17953.8j
CU - Currency Unit (Peso: Philippine) Al - Area Unit (Hectare) RU - Recommendation Unit (kghay Total amount Unit (kg &
FertilizerSources I Home | Help | Save As Copy to Cliphoard | Print | Exit |
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Example 3: Oilpalm, Indonesia

1. Select Rupiah: Indonesia and enter the exchange rate to the US$, then select Hectare as Area Unit
and kg/ha as Recommendation Unit used in Indonesia. Verify that the conversion factors are correct.
Click [Save] to make your selection active.

Units

Currency Unit Area Unit Recommendation Unit

1Us$=| 8500 [Rupiah: Indonesian  ~|| 1ha=|  1.0[Hectare | 1kgma=|  1.0[kgma =]

Save | Delete |

2. Enter the Crop/Field information: A fertilization program needs to be developed for a 750-ha oilpalm
plantation.

Crop/Farm Info

Crop Qilpalm Farm/FieldID F12 Total Area 750 Hectare

3. Enter the target amounts of nutrients to apply: Oilpalm is grown on tropical soils with low to medium
nutrient status and the fertilizer program must supply the following nutrient amounts, none of those is
to be ignored:

I | o
Kkgha kg/ha
Target Amounts [ 1m0 | e E [ 2 EE] G
Equivalent in Element | 180 | 26 | 208 | 12 | 25 | 5
[ lghore [ lgnore [ lghore [ lgnore [ lanore [ lgnore
Fertilizer Sources | Calculate | Help | Abhout | Exit

Copyright 2004 by University of Nebraska-Lincoln, Facific Rim Palm Oil Limited, and Intemational Rice Research Institute. All rights reserved.

4. Select and edit locally available fertilizer sources. Choices to consider are:
Nitrogen sources: Urea, Rp. 1,500/kg
Ammonium sulfate, Rp. 1,300/kg

Phosphorus sources: Rock phosphate, fine, Rp. 625/kg
Triple superphosphate, Rp. 1,900/kg
SP-36, Rp. 1,400/kg
DAP, Rp. 3,250/kg

Potassium sources: KCI (muriate of potash — MOP), Rp. 2,000/kg
Potassium sulfate, Rp. 2,800/kg

Magnesium, sulfur, boron: Kieserite, Rp. 1,200/kg
Dolomite, Rp. 290/kg

Magnesium sulfate (Epsom salt), Rp. 1450/kg
Na borate (48% B), Rp. 6,000/kg

e Save those choices in a custom table by clicking on File > Save As
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Efertilizer Sources ( oilpalm_Indonesia.mdb } =] 3]

File Wiew Help

CU = Currency Unit {Rupiah: Indonesian) AU = Area Unit { Hectare ) RU = Recommendation Unit { kg/ha )
CUiAU = Application Cost {Rupiah: IndonesianHectare) CUMU = Fertilizer price quote WU = Weight Unit {for fertilizer price quote
Fetilizer Source Ty... | Weigh..| Price | AppC..| hlinA.. N |P2.| k20| 8§ Zn | Fe | Cu | Mn B | Cad| MgO
LY | CUML | (CLEALD L (RLY % % % % % % % % % k3 %
v |Ammonium sulfate (21-... |solid kg 1300.0 0.0 0.0f 1.0 24.0
¥ Urea (46-0-0) solid |ky 1500.0 0.0 0.0 46.0
[V |Diammonium phosphat. . | solid (kg 3250.0 0.0 0.0/ 18.0| 46.0
[¥ |Rock phosphate, fine solid |ky 525.0 0.0 0.0 11.0/ 32.0
v |5P-36 solid |ky 1400.0 0.0 0.0] 36.0
¥ |Superphosphate, triple  |=olid |ky 1900.0 0.0 0.0 45.0 1.5 18.0
¥ Potassium chioride (MO... solid (kg 2000.0 0.0 0.0 60.0
v |Potassium suliate golid |ky 2800.0 0.0 0.0 50.0| 18.0
[v \Dolomite salid |ky 290.0 0.0 0.0 30.0[ 16.0
v Kieserite solid |kg 1200.0 0.0 0.0 220 45.0
[¥ \Magnesium sulfate (Ep... |salid kg 1450.0 0.0 0.0 13.0 17.0
v |Ma-Borate solid |kg 6O00.0 0.0 0.0 48.0
Select All | Deselect All | Insert Row | Delete Row | Help | Home Calculate

All application costs are set to zero because they are included in the prices quoted for fertilizers. Manual
spreading is US$15 per ton of fertilizer; mechanical spreading is US$5 per ton.

5. Click [Calculate] and review the result:
=10

File Wiew Help

-Crop/Farm Info

Crop Name |0i|pa|m Field |[F12 Total Area 750 Hectare
N P205 K20 IMgU ~| |s ¥ IE M

Target (kg/ha) | 180 | 60 | 250 | 20 | 25 | 5
Result (ky/ha) I 180 I 60 I 250 I 20 I 25 I 5
i Nutrients supplied with each fertilizer
Recommended Fertilizers [ H P05 | k20 | mMgo s | B
Wmmonium sulfate (21-0-0-24) 13 0 0 15 0
Urea (46-0-0) 146 0 0 0 0 ]
Rock phosphate, fine 21 B0 0 0 0 0
Fatassium chloride (MOP,0-0-60) 0 0 250 0 0 0
lieserite 0 0 0 20 10 ]
Ia-Barate 0 0 0 0 5
rRecommended amounts and cost of fertilization
Recommended Fertilizers | Price | {CUANUY App.Cost{CUWAL) | Amount{RU) | Cost{CL/AU) T.Amountikg) T.Cost{CU)
Wmmonium sulfate (21-0-0-24) 1300.0 Rupiahfkg 0o 63.4 82,420 47 850 51,815,000
Urea (46-0-0) 1800.0 Rupiahikg 0o 31758 476,250 235125 357,187 500
Fock phogphate, fine 625.0 Rupiahikg 0o 1|78 1171878 140 B25 87,880 625
Fotasgium chloride (MOP 0-... 2000.0 Rupiahikg 0o 4167 833,400 312525  ©25,050,000
liegerite 1200.0 Rupiahikg 0o 44.4 53,250 33300 39,960,000
Ia-Barate BO00.0 Rupiahikg 0o 10.4 52,400 7500 46,500,000
Tetal 0.0 1,039.9 1,624937.5 779,9251,218,703.1...
CU - Currency Unit {(Rupiah: Indonesian) AU - Area Unit (Hecta... RU- Recommendation Unit (...  Total amount Unit _ZI
FertilizerSources Home | Help | Save As Copy to Clipboard | Print | Exit |
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The total cost of this fertilizer program is Rs. 1.625 million/ha or US$191/ha. Urea is the most cost-
effective N source available and supplies most of the recommended N dose. Finely ground rock
phosphate is the least costly P source. Because the soil is acid (pH 4.5), this is a viable option. For
comparison, if rock phosphate is not available or not desirable, the next best solution would be one
with triple superphosphate, which increases the total cost by 11% to Rs. 1.823 million/ha

(US$214.5/ha):
=k
File | Wiew Help
Crop/Farm Info
Crop Name IOinaIm Field F12 Total Area 750 Hectare
N P205 K20 IMgO LI IS LI IB LI
Target (cgha) | 160 | 60 | 20 | = | = I
Result {kg/ha) I 180 I 60 I 250 I 20 I 25 I 5
 Nutrients supplied with each fertilizer
Recommended Fertilizers | H | pws | ko | mgo | s | B8 |
Ammonium sulfate (21-0-0-24) 12 0 0 0 13 0
Urea (46-0-0) 165 0 0 0 0 0
Superphosphate, triple 0 G0 0 0 2 0
Paotassium chlaride (MOP 0-0-50) 0 0 250 0 0 0
Kieserite 0 0 0 20 10 0
Ia-Barate 0 0 0 0 0 8
~Recommended amounts and cost of fertilization
Recommended Fertilizers I Price I {CUMW App.Cost{CUL.. | Amount{RU} | Cost{CL/AL} T.Amount{kg) T.Co=t{CU}
wmmonium sulfate (21-0-0-24)1300... Rupiah/kg 0o 5.1 71,630 41325 63722500
Urea (46-0-0) 1800... Rupiah/kg 0o 366.2 549 300 274650 411975000
Superphosphate, triple 1900... Rupiah/kg 0.0 1333 253270 99975 189952 500
Potassium chloride (MOP D... 2000... Rupiah/kg 0o 416.7 833 400 32525 B25,050,000
Kieserite 1200... Rupiah/kg 0o 44.4 43,280 33300 39,960,000
Ma-Borate B000. .. Rupiah/kg 0o 104 62,400 7,800 45800000
Total 0.0 1,026.1 1,823,280 769,575 1,367 460.,...
CU - Currency Unit {Rupiah: Indonesian) AU - Area Unit (Hecta... RU - Recommendation Unit (... Total amount Unit kg hd l
tilizersources | Home | Help | Save As Copyto Clipboard | Print | Exit |

Kieserite provides all of the magnesium and nearly half of sulfur required. We may explore, however,
how much difference it would make to use Dolomite as the primary Mg source, assuming that it is
available as finely ground material and would also be of benefit for raising the pH of this acid soil.
Thus, we modify the original choice of available fertilizers by de-selecting Kieserite under [Fertilizer
Sources]:
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Efertilizer Sources { cilpalm_Indonesia.mdb } & Ellzl

File Wiew Help

CU = Currency Unit (Rupiah: Indonesian) AU = Area Unit { Hectare ) RU = Recommendation Unit { kiha )
CU/AU = Application Cost (Rupiah: IndonesianHectare) CUMYU = Fertilizer price quote WU = Weight Unit {for fertilizer price quote
Ferilizer Source Ty... | Weigh...| Price | AppC..| MinA.. N |P2.|K20| 5 Zn Fe | Cu | Mn B | Cad| MgD
0L | CUnAL | (CLALD L (R % % % % % % % % % k) %
¥ Ammonium sulfate (21-.. |solid (kg 1300.0 0.0 0.0 21.0 24.0
v Urea (46-0-0) solid kg 1500.0 0.0 0.0 46.0
¥ Diamrnonium phosphat... solid (kg 32500 0.0 0.0 18.0] 46.0
v |Rock phosphate, fine golid |ky 625.0 0.0 0.0 11.0f 32.0
¥ |SP-36 solid |ky 1400.0 0.0 0.0) 36.0
¥ |Superphosphate, triple  |=olid kg 1900.0 0.0 0.0 45.0 1.6 18.0
¥ Potassium chloride (MO... solid (kg 2000.0 (IN1) 0.0 60.0
v |Potassium suliate golid |ky 2800.0 0.0 0.0 &0.0| 18.0
[¥ \Dolomite salid |ky 290.0 0.0 0.0 30.0[ 16.0
[ Kieserits solid |ky 1200.0 0.0 0.0 22.0 45.0
¥ Magnesium sulfate (Ep... |solid [ky 1450.0 [IN1) 0.0 13.0 17.0
v |Ma-Eorate solid |ky 5000.0 0.0 0.0 48.0
Select All Deselect All Insert Row Delete Row Help Home " Calculate

Recalculation results in a solution that has nearly the same cost as the original solution, costing about

is Rs. 1.633 million/ha or US$192/ha. In this case all sulfur is provided by ammonium sulfate and we

may choose this program or the first solution, depending on our own priorities for soil management.
=lo x|

File View Help

Crop/Farm Info
Crop Name IOinaIm Field F12 Total Area 750 Hectare
N P205 K20 |Mgo - | IS LI IB = |
Target (kyha) | 180 | o0 | 20 | = I E
Result (kg/ha) I 180 | 60 | 250 I 20 | 25 I 5
Nutrients supplied with each fertilizer
Recommended Fertilizers | W | pos | ko | mgo | s | B |
Amrmonium sulfate (21-0-0-24) 22 0 0 0 25 0
Urea (46-0-0) 137 ] ] ] ] ]
Rock phosphate, fine 21 21 1] 1] u] 1]
Potassium chloride (MOP 0-0-80) 0 0 250 0 0 0
Dolomite ] ] ] 20 ] ]
a-Borate 0 0 0 0 0 g
~Recommended amaounts and cost of fertilization
Recommended Fertilizers | Price | (cumy | app.costicumu) | amountiruy | costicuiau) | T.Amount{kg) | T.costicy |
Ammanium sulfate (21-0-0-24) 1300... Rupiah/kg 0.0 1042 135,460 78,150 101,595 000
Urea (46-0-0) 1800... Rupiah/ky 0.0 29549 448 350 2241758 336,262 500
Rock phosphate, fine B25.0 Rupiah/ky 0.0 1875 1171875 140 B25 g7 B0 E25
Patassium chloride (MOP 0. 2000... Rupiah/kg 0.0 416.7 833,400 MN2525 625,050,000
Daolamite 290.0 Rupiah/ky 0.0 125 36,250 93,750 27 187 500
MNa-Borate B000.... Rupiah/ky 0.0 0.4 52,400 7800 46,800,000
Total 0.0 1,142.7 1,633,047.5 857,0251,224,785 6...
CU - Currency Unit {Rupiah: Indonesian) AU - Area Unit (Hecta... RU - Recommendation Unit {... Total amount Unit
FertilizerSources Home | Help | Save As Copy to Cliphoard | Print | Exit |
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